
Microsoft System Info

Microsoft System Info is a basic tool for gathering system configuration information.    It is intended 
primarily to help Product Support Services (PSS) engineers determine information that could indicate 
problems with your system.



File menu commands

The File menu offers the following commands:

Save Saves a listing with the information for each 
category.

Print Prints a listing with the information for each 
category.

Run Invokes a dialog for specifying an application to 
run.

Exit Exits Microsoft System Info.



Edit menu commands

The Edit menu offers the following commands:

Copy Copies data from the list view to the clipboard.
Select All Selects all of the items in the list.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Refresh Refreshes the list of items for the current 

category.
Always on Top Toggles the option to keep MSInfo the 

topmost window.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help Topics Offers you an index to topics on which you 
can get help.

About Displays the copyright and version 
information for Microsoft System Info.



Save command (File menu)

Use this command to save a listing of all the information for the categories.



Run command (File menu)

Use this command to start another application.    This will invoke a dialog displaying a list of common 
utilities to choose from.    You can also type in the file specification or browse for the application using the 
standard file-open dialog.



Exit command (File menu)

Use this command to quit this application.    You can also use the Close command on the application 
Control menu. 



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands, such as File Save.    A check mark appears next to the menu item when the Toolbar is 
displayed.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Microsoft System Info.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button.    A check mark appears next to the menu item when the 
Status Bar is displayed.



Status Bar

The status bar is displayed at the bottom of the main window.    To display or hide the status bar, use the 
Status Bar command in the View menu.

This area describes actions of menu items as you use the arrow keys to navigate through menus.    This 
area similarly shows messages that describe the actions of toolbar buttons as you depress them, before 
releasing them.    If after viewing the description of the toolbar button command you wish not to execute 
the command, then release the mouse button while the pointer is off the toolbar button.



Help Topics command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Microsoft System Info and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Microsoft System 
Info.



Context Help command 

Use the Context Help command to obtain help on some portion of Microsoft System Info.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.   
Then click somewhere in the application window, such as another Toolbar button.    The Help topic will be 
shown for the item you clicked.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Print command (File menu)

Use this command to print a listing of all the information for the categories.

Note: If your system is configured for VoiceView modem support, you will have the option of sending the 
information over the modem.



Select All command (Edit menu)

Use this command to select all of the items displayed in the list view.



Refresh command (View menu)

Use this command to refresh the list of items for the current category.    For instance, if the System 
category is shown, this command can be used to update some of the statistics shown, such as available 
memory.



Always on Top command (View menu)

Use this command to force Microsoft System Info’s window frame to always remain visible, even if 
another application’s window has the input focus.



System Info

Generates a report of data about your computer.    This information is useful when attempting to 
troubleshoot system problems.

To view information on a specific category, highlight the category in the left pane.    You can sort a column 
by clicking on the column's heading.

You can copy the data from selected rows in the right pane.    Click in the first column of the row(s) you 
want to copy and choose Edit, Copy (or ctrl-C).    The data is tab delimited, so you can easily paste it into 
Excel worksheets.



System

Lists information about your computer's hardware. 



Items for System Category

Operating System:    The software controlling file and disk access on your computer.

Windows version:  The currently active Windows version number.

Processor:    The type of CPU (central processing unit).

Total physical memory:    The total amount of installed RAM (random access memory).

Available physical memory:    The amount of free physical RAM in kilobytes.

USER memory available:    The percent of free resources in the Windows User component.

GDI memory available:    The percent of free resources in the Windows Graphic Design Interface (GDI).

Swap file size:    The size of the system file used to implement virtual memory. 

Swap file usage:    The percentage of the Windows swap file that is in use.

Swap file setting:    The swap file configuration (e.g, dynamic vs. fixed limit).

Available space on drive <x:>:  The free disk space (in kilobytes) on a specific drive.
. . .

Windows directory:    The fully qualified path to the main Windows directory.

TEMP directory:    The fully qualified path to the system’s temporary directory.



Virtual Memory

A memory management technique to allow more programs to be active at the same time.    Since physical
memory is expensive, disk space is used to extend the amount of logical memory that programs can 
access.    When a new program is run, infrequently used components or data of other programs can be 
moved out of physical memory to a special swap file on disk.



Kilobyte (KB)

A measurement of memory or disk space.    1 kilobyte (KB) equals 1024 bytes or characters.



Printing

Displays information about installed printer drivers.



Items for Printing Category

Default printer:    Currently active printer.

Using print manager spooling?:    Indicates if the printer output is buffered through the printer manager 
instead of directly going to the printer port.

Unidriver (UNIDRV.DLL):    File information for universal printer driver.

Gen drv (GENDRV.DLL):    File information for generic library driver.

<specific printer>:    Name and file information for each printer that has been installed.
. . . 



System DLL’s

Lists the filename, version number, date stamp, file size, and build number of each DLL in the Windows’ 
system directory (e.g., c:\windows\system) and determines whether it's loaded in memory. 



Items for System DLL’s category

Each item represents a Dynamic Link Library file in the windows system directory (typically, c:\windows\
system or c:\winnt\system32).    The columns displayed are as follows:

Files:    The DLL’s filename.

Version:    The numeric version code (e.g., 4.0.0.500).
Often given as <major>.<minor>.<revision>.<build>. 

Date:    The date that the DLL was produced (“build” date).

Size:    Size of the file in bytes.

Loaded:    Indicates if the DLL is active (loaded in memory).

Build No.:    Version code including build identification.



Font

Shows information about your system's font engine. 



Font Substitutions

Displays the font substitutions for common fonts that are not installed.



Font Managers

Lists the current application that controls font size, format, design, and layout.



Proofing

Displays information about your thesaurus, spelling, and grammar checkers.



Registry Settings

Displays proofing tool information found in the Windows registry.



INI Settings

Displays proofing tool information found in the Win.ini file.



File Info

Lists the filename, version number, file date, file size, build number, and fully qualified path of each file 
associated with your proofing tools.    This category also determines whether the file is currently loaded in 
memory.



Graphic Filters

Lists data about your graphic import and export capability.



Registry Settings

Displays graphic filter information found in the Windows registry.



INI Settings

Displays graphic filter information found in the Win.ini file.



File Info

Lists the filename, version number, file date, file size, build number, and fully qualified path of each file 
associated with your graphic filters.    This category also determines whether the file is currently loaded in 
memory.



Text Converters

Lists data about your text import and export capability.



Registry Settings

Displays text converter information found in the Windows registry.



INI Settings

Displays text converter information found in the Win.ini file.



File Info

Lists the filename, version number, file date, file size, build number, and fully qualified path of each file 
associated with your text converters.    This category also determines whether the file is currently loaded 
in memory.



Display

Shows the file name, version date, and size of the current video driver.



Items for Display Category

<Optional Driver Description>

<Driver Filename>:  version, date, and size in bytes.



Applications Running

Displays the Module name, Process ID number, and bitness of all active programs (EXE files).



Items for Applications Running Category

Each item represents a Windows application that is active.    The columns displayed are as follows:

Module Name:    The application’s filename including its directory path.

Process ID:    The identifier that the operating system uses for the application

16-bit:    Usually indicates if the application was designed for previous versions of Windows.
Note: some new utilities are 16-bit for compatibility reasons.



OLE Registration

Lists all the OLE server entries in the Windows registry and Win.ini file.



Registry Settings

Lists all the OLE server entries from the registry.



INI Settings

Lists all the OLE server entries from the Win.ini file.



Active Modules

Displays the Module Name, version number, file date, file size, bitness, and fully qualified path to all 
modules (drivers, fonts, dynamic link libraries, and executable files) in memory.



Items for Active Modules category

Each item represents an application extension or a system resource that is currently loaded in memory.    
The columns displayed are as follows:

Module Name:    The module’s filename.

Version:    The numeric version code (e.g., 3.51.0.1057).
Often given as <major>.<minor>.<revision>.<build>.

Date:    The date that the DLL was produced (“build” date).

Size:    Size of the file in bytes.

16-bit:    Usually indicates if the module was designed for previous versions of Windows.
Note: some new module are 16-bit for compatibility reasons.

Path:    The filename including the full specification of its location.



Custom DLL’s

Lists the filename, version number, date stamp, file size, and build number of each DLL in a user-
specified directory and determines whether it's loaded in memory.    This category is activated by the /C 
command-line option, for example “msinfo32 /c [My DLL’s] c:\mydir”. 



CD ROM

Displays a wide range of information regarding your CD ROM drive(s). In addition to showing the drive 
and volume identification,    this includes the results of a few performance tests.    The tests estimate 
sustained data transfer rate and the percentage of CPU utilization under a simulated workload. Plus, they 
check for data transfer integrity.



Disclaimer regarding CD ROM tests.

The tests incorporated into the CD ROM category are not meant to convey definitive performance results. 
They are included to provide Microsoft PSS with a rough indication of drive performance, in case this 
might be causing problems.



Items for CD ROM Category

Each item represents a local CD ROM drive on your system.    The numerous columns displayed are as 
follows:

Drive:    The logical drive letter assigned to the drive.

Volume:    The identifier for the CD currently in the drive.

Total Space:    The disk space in kilobytes allocated on the current CD.

Transfer File:    The file used for testing transfer rate.

Transfer Size:    Size of the transfer file in bytes.

Data Transfer Rate: Estimated rate for sustained data transfer.

CPU Util @ 300KB/s: Estimated drive/driver CPU utilization when accessing data at 300 kilobytes per 
second (the MPC II standard) under a simulated workload.

Integrity File:    File used for checking drive data transfer integrity

Integrity Size: Size of the integrity file in bytes.

Data Transfer Integrity:    Indicates if the test file was read successfully.

Device:    Operating system hardware identifier for the CD ROM drive.

Description: Manufacturer-specific description usually indicating model number.



Audio

Displays information about multimedia drivers for audio playback and recording. There are three general 
categories of driver shown: low-level drivers designed for specific sound cards; 
compressor/decompressor (CODEC) drivers handled by the system Audio Compression Manager (ACM);
and high-level drivers using the system Media Control interface (MCI).



Items for Audio Category

Each item is for a wave driver on your system. Note that the driver usually has been assigned a unqiue 
subcategory in the category tree view. This main category shows all the drivers to facilitate comparisons. 
The following information is shown for each driver:

Key:    Unique identifier for the driver.

Description:    Text description for the driver, supplied by the driver vendor.

Group:    The type of driver, such as Wave, MIDI, MCI, or ACM.

Driver:    File for the driver executable.

Status:    Group-specific status code, which might indicate if the driver is disabled.

Version:    The numeric version code (e.g., 2.5.0811) for the driver.

Date:    The date that the DLL was produced (“build” date).

Size:    Size of the file in bytes.

Loaded:    Indicates if the driver is active (loaded in memory).

Tested OK?:    Indicates whether a test of the driver has been verified by the user. 

See the Test command for testing requirements.



Video

Displays information about multimedia drivers for video playback. There are two general categories of 
driver shown: compressor/decompressor (CODEC) drivers handled by the system Installable 
Compression Manager (ICM); and, high-level drivers using the system Media Control interface (MCI). 
Note that the low-level drivers are part of the display adapter.



Items for Video Category

Each item is for a video driver on your system. Note that the driver usually has been assigned a unique 
subcategory in the category tree view. This main category shows all the drivers to facilitate comparisons. 
The following information is shown for each driver:

Key:    Unique identifier for the driver.

Description:    Text description for the driver, supplied by the driver vendor.

Group:    The type of driver, such as ICM or MCI.

Driver:    File for the driver executable.

Status:    Group-specific status code, which might indicate if the driver is disabled.

Version:    The numeric version code (e.g., 2.5.0811) for the driver.

Date:    The date that the DLL was produced (“build” date).

Size:    Size of the file in bytes.

Loaded:    Indicates if the driver is active (loaded in memory).

Tested OK?:    Indicates whether a test of the driver has been verified by the user.

See the Test command for testing requirements.



Test command (Test menu)

Use this command to test the current multimedia driver with a sample specified in the application profile.    
The sample must be appropriate for the given driver.

Note: The test command relies heavily on registry profiles for client applications (e.g., Encarta 96).    
These profiles indicate the samples appropriate for testing the drivers required by the application (usually 
on the client application’s CD).    Without these profiles and supplied samples, most drivers will not be 
testable unless you have alternative samples of the appropriate type.



Cancel command (Test menu)

Use this command to cancel the ongoing multimedia test, bypassing the confirmation dialog.

If you just want to proceed to the confirmation, stop the media playback and close the dialog.



Locate command (Test menu)

Use this command to locate an alternative sample to test the current driver.    This invokes a standard file 
browsing dialog.    Afterwards, media testing will be initiated with the chosen file.

The chosen sample must represent an appropriate test or an error will be displayed.

Note:    Some driver types are rarely used.    Thus you might not have a suitable sample available.    Before
cursing us out, keep in mind that the multimedia testing is designed for PSS support of specific Microsoft 
multimedia applications.



Configure command (Test menu)

Use this command to invoke the system utility for configuring the current multimedia driver. 

For instance, if the MIDI driver is displayed, this will invoke the Multimedia Properties from the Control 
Panel and select the MIDI tab. (Under Windows NT, this will invoke the MIDI Mapper applet of the control 
panel.)



Volume Control Icon

An object for meditation during repetitive multimedia driver testing.



Volume Control

Use this control to change the volume used during the media testing. 

This affects the master speaker of the mixer device.    The control is disabled if no mixer is found.

Note: the global setting will be restored upon exit.



Mute Control

Use this control to mute the volume used during the media testing. 

This affects the master speaker of the mixer device. The control is disabled if no mixer is found.

Note: the global setting will be restored upon exit.



Appropriate Samples.

To be an appropriate sample, the sample must be of a type specific to the driver.    For CODEC  ’  s  , a 
further requirement is that the sample has been compressed in the driver’s main format.    For instance, to
test Microsoft’s ADPCM audio CODEC, a wave file (.wav extension) must be available which has been 
compressed using the MS-ADPCM format. Any old wave file won’t suffice since many are encoded using 
vanilla PCM.



Pulse Code Modulation (PCM).

Pulse Code Modulation (PCM) is a simple scheme for encoding analog wave data in digital format. For 8-
bit wave files, there are 256 unique levels for representing the analog amplitude. An extension to this, 
called Adaptive Differential Pulse Code Modulation (ADPCM), compresses the samples by encoding the 
difference in the PCM values for consecutive samples. Microsoft ADPCM and IMA ADPCM are two of 
many variations on the ADPCM theme.



Compressor/Decompressor    (CODEC)

A compressor/decompressor driver, or CODEC, compresses multimedia data when recording to a disk file
and later decompresses the data during playback.    Multimedia titles use compression to conserve disk 
space.    The savings can be significant since multimedia files usually compress better than typical data 
files, given their regularity.    Even on compact discs, compression is important, considering the large 
number of files that multimedia applications require.

Many sound cards and video adapters don’t support compressed samples; and, those that do usually 
have a limited range.    Thus CODEC’s are used as intermediaries between the low-level drivers for the 
adapter card and the high-level drivers normally used for multimedia playback.



Compression

The process of transforming data into a compact form (suitable for long-term storage).    This generally 
involves analyzing data for regularities and substituting more space-efficient codes (e.g., ‘10000000001’ 
=> ‘10*91’, where * precedes an occurrence count).



How to Copy Data

Activate the right pane, click in the first column of the row(s) you want to copy and choose Edit, Copy (or 
ctrl-C).



How to Sort data

Activate the right pane and click on the column heading you want to sort.    A second click toggles the sort 
order.



How to Save a report

Choose File, Save (or ctrl-S).



How to Print a report

Choose File, Print (or ctrl-P).



How to Show available space on Network Drives

Select the System category while holding the shift key down.    If you are already in this category, select 
the refresh command while holding the shift key down.

To enable the display of network drives throughout the session, invoke Microsoft System Info with the /N 
command-line switch: “MSInfo32 /n”.

Note:    Network drive space is not shown by default to avoid network delays.



How to Test an audio driver

Select the Audio category to view installed audio drivers.    From the list of installed drivers, click    on the 
driver you want to test.    If there is a valid default sample to play, the Test button will be available.    If the 
Test button is not available an alternative sample will need to be located to test the driver.

If the Test button is available, click on it to play the sample.    If you hear the sample then the driver is 
configured correctly.    If you do not hear the sample, check the volume setting for your speaker.    Make 
sure your speakers are not set to mute or to a low volume setting.

If the volume settings are correct, you may need to configure the driver.    Press the Configure button to 
bring up a dialog to configure the driver.    If you do not know how to configure the driver, contact the 
manufacturer of your sound card or contact the technical support of Windows or your machine.



How to Locate an alternative sample

If a different sample is desired or needed, press the Locate button to bring up a Browse dialog box.    To 
locate a    file, use the controls in the Browse dialog box to go to a particular drive or folder.

Once an alternative file is located, click on the file to select it, and click on the Open button.    If the sample
is of the correct format, the sample will play.    If the sample is not correct, an error message will appear 
instructing you to locate another file.



How to Configure an Audio driver

To configure an Audio driver, click on the installed driver from the Audio category then click on the 
Configure button.    This will bring up the Multimedia Properties dialog in Windows 95, or the Drivers 
dialog or a mapper dialog box under Windows NT.

Under Windows 95, select the driver you need to configure, then click on the Properties button.    Make 
sure the device is selected to be used by Windows.    If the Settings button is available, click on it to check
the other settings for the device.    If the device is a codec, changing the Priority of the codec may enable 
the device work properly.

If you do not know how to configure the driver, contact the manufacturer of your sound card or contact the
technical support of Windows or your machine.

Under Windows NT, click on the Setup button.    If there is an auto-configure button, click on it to allow the 
driver to reset its settings.



How to Copy Specific Category Data

Select the specific category you want to copy the information from and from the Edit menu select copy. 
This will copy all the information that displays for that category to the clipboard so it can be pasted into a 
text editor.




